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About the User’s Guides

Your machine comes with the two user’s guides:

This Laser MFP User’s Guide provides information you need for setting up your machine 
and installing the supplied software. It also provides all of the detailed instructions for using 
your machine as a printer, a scanner and a copier and information for maintaining and 
troubleshooting the machine.

The SmarThru 4 User’s Guide provides the basic description about using the multi-function 
application. Samsung SmarThru allows you to scan and edit images, and to scan for copying, 
faxing and sending an e-mail on your computer. You can also find a brief description on the 
automatic text recognition program, AnyPage.

This manual is provided for information purposes only. All information included herein is 
subject to change without notice. Samsung Electronics is not responsible for any changes, 
direct or indirect, arising from or related to the use of this manual.

© 2004 Samsung Electronics Co., Ltd. All rights reserved.

• SCX-4100 and Samsung logo are trademarks of Samsung Electronics Co., Ltd.

• PCL and PCL 6 are trademarks of Hewlett-Packard Company.

• Microsoft, Windows, Windows 9x, Window Me, Windows 2000, Windows NT 4.0 
and Windows XP are registered trademarks of Microsoft Corporation.

• Apple, AppleTalk, TrueType, LaserWriter and Macintosh are trademarks of Apple 
Computer, Inc.

• PostScrip 3, Adobe Acrobat Reader, Adobe PhotoDeluxe and Adobe Photoshop are 
trademarks of Adobe System, Inc.

• All other brand or product names are trademarks of their respective companies or 
organizations.
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Important Precautions and Safety Information

When using this machine, these basic safety precautions should always be followed 
to reduce risk of fire, electric shock, and injury to people:

1. Read and understand all instructions.

2. Use common sense whenever operating electrical appliances.

3. Follow all warnings and instructions marked on the machine and in the literature 
accompanying the machine.

4. If an operating instruction appears to conflict with safety information, heed the 
safety information. You may have misunderstood the operating instruction. If you 
cannot resolve the conflict, contact your sales or service representative for 
assistance.

5. Unplug the machine from the AC wall socket and/or telephone jack before 
cleaning. Do not use liquid or aerosol cleaners. Use only a damp cloth for 
cleaning.

6. Do not place the machine on an unstable cart, stand or table. It may fall, causing 
serious damage.

7. Your machine should never be placed on, near or over a radiator, heater, air 
conditioner or ventilation duct.

8. Do not allow anything to rest on the power cable. Do not locate your machine 
where the cords will be abused by persons walking on them.

9. Do not overload wall outlets and extension cords. This can diminish performance, 
and may result in the risk of fire or electric shock.

10. Do not allow pets to chew on the AC power, telephone or PC interface cords.

11. Never push objects of any kind into the machine through case or cabinet 
openings. They may touch dangerous voltage points, creating a risk of fire or 
shock. Never spill liquid of any kind onto or into the machine.

12. You machine may have a heavy cover for optimal pressure on the document for 
the best scanning and/or faxing. In this case, replace the cover after placing 
document on the scan glass, by holding and moving it down slowly until it seats 
on its location.

13. To reduce the risk of electric shock, do not disassemble the machine. Take it to a 
qualified service technician when repair work is required. Opening or removing 
covers may expose you to dangerous voltages or other risks. Incorrect 
reassembly could cause electric shock when the unit is subsequently used. 

14. Unplug the machine from the telephone jack, PC and AC wall outlet, and refer 
servicing to qualified service personnel under the following conditions:
• When any part of the power cord, plug, or connecting cable is damaged or 

frayed.
• If liquid has been spilled into the machine. 
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• If the machine has been exposed to rain or water.
• If the machine does not operate properly after instructions have been followed.
• If the machine has been dropped, or the cabinet appears damaged.
• If the machine exhibits a sudden and distinct change in performance.

15. Adjust only those controls covered by the operating instructions. Improper 
adjustment of other controls may result in damage, and may require extensive 
work by a qualified service technician to restore the machine to normal operation.

16. Avoid using this machine during a lightning storm. There may be a remote risk of 
electric shock from lightning. If possible, unplug the AC power and telephone cord 
for the duration of the lightning storm.

17. SAVE THESE INSTRUCTIONS.

Laser Safety Statement

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, 
chapter 1 Subchapter J for Class I(1) laser products, and elsewhere is certified as a 
Class I laser product conforming to the requirements of IEC 825.

Class I laser products are not considered to be hazardous. The laser system and 
printer are designed so there is never any human access to laser radiation above a 
Class I level during normal operation, user maintenance, or prescribed service 
condition.

WARNING 

Never operate or service the printer with the protective cover removed from Laser/
Scanner assembly. The reflected beam, although invisible, can damage your eyes.
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Ozone Safety

During normal operation, this machine produces ozone. 
The ozone produced does not present a hazard to the 
operator. However, it is advisable that the machine be 
operated in a well ventilated area.

If you need additional information about ozone, please 
request your nearest Samsung dealer.

Power Saver

This machine contains advanced energy conservation 
technology that reduces power consumption when it is not 
in active use.

When the machine does not receive data for an extended 
period of time, power consumption is automatically 
lowered. 

The energy star emblem does not represent EPA 
endorsement of any machine or service.

Recycling

Please recycle or dispose of the packaging material for this 
product in an environmentally responsible manner.
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Radio Frequency Emissions

FCC Information to the User

This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

CAUTION: Change or modifications not expressly approved by the manufacturer 
responsible for compliance could void the user's authority to operate the equipment.

Canadian Radio Interference Regulations

This digital apparatus does not exceed the Class B limits for radio noise emissions 
from digital apparatus as set out in the interference-causing equipment standard 
entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux 
appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur: 
“Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.

Fax Branding

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to 
use a computer or other electronic device to send any message via a telephone 
facsimile machine unless such message clearly contains in a margin at the top or 
bottom of each transmitted page or on the first page of the transmission the following 
information:

(1) the date and time of transmission
(2) identification of either business, business entity or individual sending the 

message; and
(3) telephone number of either the sending machine, business, business entity or 

individual.
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The Telephone Company may make changes in its communications facilities, 
equipment operations, or procedures where such action is reasonably required in the 
operation of its business and is not inconsistent with the rules and regulations in FCC 
Part 68. If such changes can be reasonably expected to render any customer terminal 
equipment incompatible with telephone company communications facilities, or 
require modification or alteration of such terminal equipment, or otherwise materially 
affect its use or performance, the customer shall be given adequate notice in writing, 
to allow the customer an opportunity to maintain uninterrupted service.

Ringer Equivalence Number

The Ringer Equivalence Number and FCC Registration Number for this machine may 
be found on the label located on the bottom or rear of the machine. In some instances 
you may need to provide these numbers to the telephone company.

The Ringer Equivalence Number (REN) is a measure of the electrical load placed on 
the telephone line, and is useful for determining whether you have “overloaded” the 
line. Installing several types of equipment on the same telephone line may result in 
problems making and receiving telephone calls, especially ringing when your line is 
called. The sum of all Ringer Equivalence Numbers of the equipment on your 
telephone line should be less than five in order to assure proper service from the 
telephone company. In some cases, a sum of five may not be usable on your line. If 
any of your telephone equipment is not operating properly, you should immediately 
remove it from your telephone line, as it may cause harm to the telephone network.

WARNING:

FCC Regulations state that changes or modifications to this equipment not expressly 
approved by the manufacturer could void the user’s authority to operate this 
equipment. In the event that terminal equipment causes harm to the telephone 
network, the telephone company should notify the customer that service may be 
stopped. However, where prior notice is impractical, the company may temporarily 
cease service, providing that they:

a) promptly notify the customer.

b) give the customer an opportunity to correct the equipment problem.

c) inform the customer of the right to bring a complaint to the Federal Communication 
Commission pursuant to procedures set out in FCC Rules and Regulations Subpart 
E of Part 68.
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You should also know that:

• Your machine is not designed to be connected to a digital PBX system.

• If you intend to use a computer modem or fax modem on the same phone line as 
your machine, you may experience transmission and reception problems with all 
the equipment. It is recommended that no other equipment, except for a regular 
telephone, share the line with your machine.

• If your area experiences a high incidence of lightning or power surges, we 
recommend that you install surge protectors for both the power and the telephone 
lines. Surge protectors can be purchased from your dealer or telephone and 
electronic specialty stores.

• When programming emergency numbers and/or making test calls to emergency 
numbers, use a non-emergency number to advise the emergency service 
dispatcher of your intentions. The dispatcher will give you further instructions on 
how to actually test the emergency number.

• This machine may not be used on coin service or party lines.

• This machine provides magnetic coupling to hearing aids.

• You may safely connect this equipment to the telephone network by means of a 
standard modular jack, USOC RJ-11C.
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Declaration of Conformity (European Countries)

Approvals and Certifications

The CE marking applied to this product symbolizes Samsung 
Electronics Co., Ltd. Declaration of Conformity with the following 
applicable 93/68/EEC Directives of the European Union as of the 
dates indicated:

January 1, 1995: Council Directive 73/23/EEC Approximation of the laws of the 
member states related to low voltage equipment.

January 1, 1996: Council Directive 89/336/EEC (92/31/EEC), approximation of the 
laws of the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and 
telecommunications terminal equipment and the mutual recognition of their 
conformity.

A full declaration, defining the relevant Directives and referenced standards can be 
obtained from your Samsung Electronics Co., Ltd. representative.

EC Certification

Certification to 1999/5/EC Radio Equipment & Telecommunications 
Terminal Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European single 
terminal connection to the analogue public switched telephone network (PSTN) in 
accordance with Directive 1999/5/EC. The product has been designed to work with 
the national PSTNs and compatible PBXs of European countries.

In the event of problems, you should contact the Euro QA Lab of Samsung Electronics 
Co., Ltd. in the first instance.

The product has been tested against TBR21. To assist in the use and application of 
terminal equipment which complies with this standard, the European 
Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 
201 121) which contains notes and additional requirements to ensure network 
compatibility of TBR21 terminals. The product has been designed against, and is fully 
compliant with, all of the relevant advisory notes contained in this document. 
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Replacing the Fitted Plug (for UK Only)

IMPORTANT

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and 
has a 13 amp fuse. When you change or examine the fuse, you must re-fit the correct 
13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, 
do not use the plug until you have another fuse cover. 

Please contact the company from where the machine was purchased.

The 13 amp plug is the most widely used type in the UK and should be suitable. 
However, some buildings (mainly old ones) do not have normal 13 amp plug sockets. 
You need to buy a suitable plug adaptor. Do not remove the moulded plug.

WARNING

If you cut off the moulded plug, get rid of it straight away.
You cannot rewire the plug and you may receive an electric shock if you plug 
it into a socket.

IMPORTANT WARNING: You must earth this machine.

The wires in the mains lead have the following color code:

• Green and Yellow:       Earth

• Blue:                         Neutral

• Brown:                      Live

If the wires in the mains lead do not match the colors marked in your plug, do the 
following:

You must connect the green and yellow wire to the pin marked by the letter “E” or by 
the safety `Earth symbol' or colored green and yellow or green.

You must connect the blue wire to the pin which is marked with the letter “N” or 
colored black.

You must connect the brown wire to the pin which is marked with the letter “L” or 
colored red.

You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.
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Differences Between British and American English

WARNING

• Do not disassemble the machine as it may give you an electric shock.

• If you print large amount of copies, the surface of the output tray may become 
hot. Be careful not to touch the surface, and keep children away from the surface.

British English American English

(Re)dialling (Re)dialing

Colour Color

Emphasise Emphasize

Recognise Recognize

Organise Organize

Authorise Authorize

Cancelling Canceling

Customise Customize

Socket Jack

Labelling Labeling



1 GETTING STARTED

Thank you for purchasing this multifunctional product. 
Your machine provides you with printing, copying, and 
scanning functions!

This chapter gives you step-by-step instructions for 
setting up your machine.

This chapter includes:

• Unpacking

• Understanding the Component Location

• Installing the Toner Cartridge

• Loading Paper

• Making Connections

• Turning the Machine On

• About Samsung Software

• Installing Samsung Software in Windows

• Repairing Software

• Removing Software

• Changing the Display Language

• Setting the Paper Size and Type

• Using the Save Modes
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Unpacking

Remove the machine and all accessories from the packing 
carton. Make sure that the machine has been packed with the 
following items. If there is a missing item, contact the retailer 
where you bought the machine:

Remove the packing tape from the front, back and sides of the 
machine.

Starter Toner Cartridge AC Power Cord*

* The appearance of the power cord may differ according to your country’s 
specifications.

Quick Install Guide CD-ROM**

** The CD-ROM contains the MFP driver, SmarThru software, the user’s guides 
and the Adobe Acrobat Reader program.

NOTES: 
• The power cord must be plugged into a grounded power socket.
• Components may differ from one country to another.

Tape
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1
Selecting a Location

Select a level, stable place with adequate space for air 
circulation. Allow extra space for opening covers and trays. 

The area should be well-ventilated and away from direct sunlight 
or sources of heat, cold and humidity. Do not set the machine 
close to the edge of your desk or table. 

Clearance Space

• Front: 482.6 mm (enough space so that the paper trays can be 
removed)

• Back: 250 mm (enough space for ventilation)

• Right: 100 mm

• Left: 100 mm (enough space for ventilation)
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Understanding the Component 
Location

These are the main components of your machine:

Front View

Rear View

Paper Tray

Front Output Tray
(Face down)

Control Panel 
(see the page 1.5)

Manual Feeder

Manual Feeder
Guides

Front Paper
Output

Extension

Toner 
Cartridge

Document
Glass

Document Cover

Front Cover

Parallel Connector

USB ConnectorRear Cover

AC Power Cord Connector

Rear Output Slot 
(Face up)

Power Switch

Paper Length Guide
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1Control Panel Functions

1
C
O
P
Y

Adjusts the brightness of the documents for 
the current copy job. 

Selects the number of copies.

2 Displays the current status and prompts 
during an operation. 

3

Scrolls through the options available for the 
selected menu item.

Enters Menu mode and scrolls through the 
menus available and sends you back to the 
upper menu level.

4

Stops an operation at any time.
In Standby mode, clears/cancels the copy 
options, such as the darkness and the number 
of copies. 

 5

Confirms the selection on the display and 
starts a job.
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 Installing the Toner Cartridge

1 Open the front cover.

2 Remove the starter toner cartridge from its bag. Don’t use 
a knife or other sharp object as it might scratch the drum of 
the cartridge.

3 Gently roll the cartridge 5 or 6 times to distribute the toner 
evenly inside the cartridge.

Thoroughly rolling the cartridge will assure the maximum 
copies per cartridge.

CAUTIONS:
• To prevent damage, do not expose the toner cartridge to light for 

more than a few minutes. Cover it with a piece of paper if left 
exposed for more than a few minutes, and keep it flat and clean 
place.

• If toner gets on your clothing, wipe it off with a dry cloth and 
wash clothing in cold water. Hot water sets toner into the fabric.
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1
4 Slide the toner cartridge into the machine until it locks into 

place completely.

5 Close the front cover. Make sure that the cover is securely 
closed.

NOTE: When printing text at 5% coverage, you can expect a toner 
cartridge life of approximately 3,000 pages (1,000 pages for the 
toner cartridge that is shipped with the printer).



GETTING STARTED1.8

Loading Paper

You can load approximately 250 sheets.

To load a stack of Letter-sized paper:

1 Pull open the paper tray and remove it from the machine.

2 Push down on the pressure plate until it locks into place.

3 Fan the edges of the paper stack to separate the pages. 
Then tap the stack on a flat surface to even it up.
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1
4 Insert the paper stack into the paper tray with the side you 

want to print on facing down.

You can load previously printed paper. The printed side 
should be facing up with an uncurled edge on top. If you 
experience problems with paper feed, turn the paper 
around.

5 Pay attention to the paper limit mark on the left inside wall 
of the tray. Paper overloading may cause paper jams.

6 Insert and slide the paper tray back into the machine.
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NOTE: After you load the paper, you need to set up your machine 
for the paper type and size you loaded. See page 1.26 for copying, 
or page 3.7 for PC-printing.

Changing the Paper Size in the Paper Tray

To load longer sizes of paper, such as Legal-sized paper, you 
need to adjust the paper guides to extend the paper tray.

1 After pressing and unlatching the guide lock, slide the 
paper length guide outward as far as it will go. This extends 
the length of the tray.

2 After inserting paper into the tray, slide in the guide until it 
lightly touches the end of the paper stack. For paper 
smaller than letter, adjust the paper length guide 
accordingly.

3 Pinching the paper width guide as shown, move it toward 
the stack of paper until it lightly touches the side of the 
stack.
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1NOTES:
• Do not push the paper width guide far enough to cause the 

materials to warp.
• If you do not adjust the paper width guide, it may cause paper 

jams.

Making Connections

1 Connect a USB cable to the USB connector on your 
machine.

You must purchase a USB 1.1 compliant cable that is no 
more than 3 m in length.

2 If you want to use a parallel printer cable, purchase only an 
IEEE 1284 compliant parallel cable and connect it to the 
parallel connector on your machine.

Push the metal clips down to fit inside the notches on the 
cable plug.
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NOTES:
• You only need to connect one of the cables mentioned above. Do 

not use the parallel and the USB cables at the same time.
• If you are using a USB cable, you must be running Windows 98/

Me/2000/XP. 
• When using the USB connection, your machine provides two USB 

modes; Fast and Slow. Fast is the default mode. Some PC users 
may experience poor USB function in the default mode. If this 
occurs, select the Slow mode to achieve successful results. For 
details about changing the USB mode, see page 8.12.

Turning the Machine On 

1 Plug one end of the supplied three-pronged electrical type 
cord into the AC socket on the machine and the other end 
into a properly grounded AC outlet. 

2 Press the power switch to turn the machine on. “Warming 
Up Please Wait” appears on the display indicating that the 
machine is now on. 

To view your display text in another language, see 
page 1.25.

CAUTIONS:
• The fusing area inside the rear part of your machine becomes hot 

once the machine is turned on. Be careful when you access this 
area.

• Do not disassemble the machine when it is turned on as it may 
give you an electric shock.

 ➜ To the AC walljack
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1Installing Software

About Samsung Software

You must install software using the supplied CD-ROM after you 
have set up your machine and connected it to your computer. 
The CD-ROM includes:

• Samsung software

• User’s Guides

• Adobe Acrobat Reader

The CD-ROM provides you with the following software:

Windows GDI Driver 
To use your machine as a printer and scanner in Windows, you 
must install the GDI driver. For information about installing the 
GDI driver in Windows, see page 1.15.

Macintosh Printer Driver
You can use your machine with Macintosh. For information about 
installing the printer driver from Macintosh, see page 6.2.

Linux Driver

You can print and scan in Linux using your machine. For 
information about installing the printer driver in Linux, see 
page 6.15. 

Remote Control Panel
This Windows-based program is automatically installed when 
you install the GDI driver. For information about using the 
program, see page 6.31.

SmarThru Software
SmarThru is the accompanying Windows-based software for 
your multifunctional machine. SmarThru contains a powerful 
image editor that allows you to edit images in many ways and 
also includes powerful Internet mail client software. With 
SmarThru, you can save the scanned images in a dedicated 
storage area for subsequent editing, sending via e-mail or fax, 
printing and processing by other programs of your choice.
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OCR Software (AnyPage Lite)

AnyPage Lite, the OCR (Optical Character Recognition) program, 
is Windows-based software that has the ability to recognize 
most character formats so that a scanned document can be read 
and edited with word processing software. 

NOTES: 
• In case of Chinese, it does not support the OCR function.
• OCR is available only for languages supported by AnyPage Lite. 

Supported languages are Africans, Albanian, Basque, Bulgarian, 
Byelorussian, Catalan, Croatian, Czech, Danish, Digits, Dutch, 
English, Estonian, Finnish, French, German, Hungarian, 
Icelandic, Indonesian, Irish, Italian, Latvian, Lithuanian, 
Macedonian, Norwegian (Bokmal), Norwegian (Nynorsk), Polish, 
Portuguese, Romanian, Russian, Serbian, Slovak, Spanish, 
Swahili, Swedish, Tagalog, Turkish, Ukrainian, Korean.

• Recommended Scan Option for OCR
Resolution: 200 or 300 dpi
Image Type: Mono(Black & White)

Printer Driver Features
Your printer drivers support the following standard features:
• Paper source selection
• Paper size, orientation and media type
• number of copies
The following table lists a general overview of features 
supported by your printer drivers. 

NOTES:
• Some of feature are not supported on Mac OS 10.X such as 

Paper Type, Grayscale and Black&White.
• The Watermark feature is not supported on Mac OS 9.1 or higher.

Feature
Printer Driver

Win9x/Me Win2000/XP WinNT4.0 Macintosh Linux

Toner Save Y Y Y N Y

Print quality option Y Y Y Y Y

Poster printing Y Y Y N N

Multiple pages per 
sheet (N-up) Y Y Y Y Y(2,4)

Fit to page printing Y Y Y N Y

Scale printing Y Y Y Y Y

Watermark Y Y Y Y N

Overlay Y Y Y N N
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1Installing Samsung Software in 
Windows

System Requirements

Before you begin, ensure that your system meets the minimum 
requirements.

Supported Operating System

• Windows 95 OSR2

• Windows 98/Windows 98 SE

• Windows Me

• Windows NT 4 Workstation or Server with Service Pack 3

• Windows 2000 Professional or Advanced Server

• Windows XP Home edition or Professional.

Minimal Requirements

• Disk space: 120 MB for installation 

• Memory: 64 MB 

• CPU: Pentium II 233 or higher

• Required software: Internet Explorer 4.01

Recommended

• Disk space: 300 MB for installation

• Memory: 128 MB

• CPU: Pentium II 400 or higher

• Required software: Internet Explorer 5.5

NOTES:
• For Windows NT 4.0/2000/XP, the system administrator should 

install the software.
• Windows 95 versions prior to OSR2 are not recommended due to 

incompatibility with OLE/COM libraries.
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Installing Samsung Software

NOTES: 
• Cancel the “New Hardware Found” window when your 

computer boots up.
• Make sure that your machine is turned on and connected to your 

computer’s parallel port or USB port before installing 
software. Windows 95 and Windows NT 4.0 do not support the 
USB connection.

1 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter of your drive and click OK.

2 When the following window opens, connect your machine to 
the computer and turn the printer on. Then click Next.

If the machine is already connected and turned on, this 
screen does not appear. Skip to the next step.

NOTE: If you click Next and the machine is not connected to the 
computer, an alert message window appears. After connecting the 
machine and turning it on, click Yes. Or, if you want to install the 
software without the machine, Click No.
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1
3 Choose the installation type. 

•Typical: Installs the common software for your printer, 
such as printer driver, Twain driver, Remote Control Panel. 
This is recommeded for most users.

•Custom: Allows you to choose the language of the 
software and the components you want to install. After 
selecting the language and the component(s), click Next.

•Install SmarThru: Installs the SmarThru program. If you 
select to install SmarThru on this screen, follow from step 
3 on page 1.19. 

•View User’s Guide: Allows you to view this User’s Guide 
or SmarThru User’s Guide. If your computer doesn’t have 
Adobe Acrobat, click on this option and it will automatically 
install Adobe Acrobat for you.

4 After the installation is finished, the window asking you to 
print a test page appears. If you choose to print a test 
page, select the check box and click Next.

Otherwise, Skip to step 6.
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5 When the test page prints out correctly, click Yes.

If not, click No to reprint it.

6 To register yourself as a user of Samsung Printers, select 
the check box and click Finish. You are now accessed to the 
Samsung web site.

Otherwise, just click Finish.

NOTES:
• When you want to use your machine with the parallel cable, 

remove the USB cable and connect the parallel cable. Then 
reinstall the printer driver; select Start → Programs → 
Samsung SCX-4100 Series → Maintenance → Repair → 
Printer. If you have replaced the parallel cable with the USB 
cable, do the same to reinstall the driver.

• If your printer doesn’t work properly, reinstall the printer driver.
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1
Installing Samsung SmarThru

1 Insert the supplied CD-ROM into your CD-ROM drive.

2 Click Install SmarThru.

3 Click Next.

4 Follow the on-screen instructions and click Next.

5 Click Next.

6 Select the installation type and click Next.
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The software installation supports two types of setup:

• Typical: Program will be installed with the most common 
options and is recommended for most users.

• Custom: You may choose the options you want to install.

7 Choosing the SmarThru networking option allows you to 
share the modems on other computer in your network, and 
the scan device or to access similar devices on other 
computers. 

If you select the Custom installation, you may choose the 
components you want to install.

• SmarThru Software: to scan and edit images 
   and to work with electronic documents.
• OCR Software: AnyPage Lite software to enable OCR. 
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1
Stand-alone configuration does not allow you to use any 
networking features, such as Remote Fax or Remote Scan 
service.

When you select SmarThru networking, you can elect to 
install it as a Server, a Client or both. 

The Server option allows you to share a local fax modem 
and/or a scanner over a LAN. You can control sharing by 
managing a remote service user. The Client option allows 
you to use Remote Fax or Remote Scan services provided 
by a SmarThru Server over a LAN. You need to have a 
client account provided by the server. For details about 
Remote Fax/Scan Services, refer to the SmarThru User’s 
Guide.

8 Follow the on-screen instructions to complete the 
installation.

9 When the installation is finished, click Finish.
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Repairing Software

Repairing is required if your installation fails or the software 
does not work properly. This Repairing procedure does not 
repair SmarThru software.

1 You can select Start → Programs → Samsung SCX-4100 
Series →Maintenance.

Otherwise, Insert the supplied D-ROM into your CD-ROM 
drive. 

2 Click Repair.

NOTE: If your machine is not connected to the computer, the 
Connect Samsung SCX-4100 Series window opens. After 
connecting the machine, click Next.

3 Select the components you want to reinstall and click Next.

If you choose to repair the printer software, the window 
asking you to print a test page appears. Do as follows:

a. To print a test page, select the check box and click Next.

b. When the test page prints out correctly, click Yes. 
If not, click No to reprint it.

4 When the reinstallation is done, click Finish. 
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1Removing Software

Uninstall is required if you are upgrading the software or if your 
installation fails. You can uninstall the item you want using the 
Windows uninstallShield.

Uninstalling the MFP Driver

1 You can select Start → Programs → Samsung SCX-4100 
Series → Maintenance.

Otherwise, Insert the supplied D-ROM into your CD-ROM 
drive. 

2 Click Remove.

Then you will see a component list so that you can remove 
any of them individually.

If you want to uninstall the printer driver, check Printer.

If you want to uninstall the twain driver, check Twain. 

If you want to uninstall the Remote Control Panel, check 
Remote Control Panel.

3 After selecting items you wish to remove, click Next.

4 When your computer asks you to confirm your selection, 
click Yes. 

The selected driver and all of its components are removed 
from your computer. 

5 When the uninstallation is done, click Finish. 
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Uninstalling Samsung SmarThru

NOTE: Before beginning uninstallation, ensure that all applications 
are closed on your computer. A system reboot is required after the 
software is uninstalled.

1 From the Start menu, select Programs.

2 Select Samsung SmarThru, and then select SmarThru 4 
Uninstall.

3 When your computer asks you to confirm your selection, 
click Ok. The Uninstall Options window appears.

Uninstall options are:

• Backup and delete: Backs up all your data and options 
to a safe place. It then removes the SmarThru system 
including the data.

• Delete: Deletes all the SmarThru data and options. No 
backup or copying takes place. Be careful while using this 
option as you can easily lose your data.

• Leave intact: Uninstalls SmarThru software leaving data 
and options intact. This can be useful, if, for example, 
you decide to install the Stand Alone configuration over 
the SmarThru Networking. In this case, uninstall 
Samsung SmarThru having the Leave intact option set 
and install the SmarThru Stand Alone configuration.

4 After selecting the uninstall option, click Next.

5 When the uninstallation is done, the message window 
recommends restarting your computer. Click OK.

6 Click Finish.

When your computer doesn’t shut down and restart 
automatically, you must shut it down manually and restart 
it before the changes are saved. 
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1Setting Up the Machine 
System

Changing the Display Language

To change the language that displays on the display of the 
control panel, follow these steps:

1 Press Menu/Exit until "Machine Setup" appears on the top 
line of the display.

2 Press the scroll button (� or �) until "Language" appears 
on the bottom line of the display.

3 Press Start/Copy. The current setting appears on the 
bottom line of the display.

4 Press the scroll button (� or �) until the language you want 
appears on the display.

5 Press Start/Copy to save the selection. 

6 To return to Standby mode, press Stop/Clear.
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Setting the Paper Size and Type

After loading paper in the paper tray, you need to set the paper 
type and size using the control panel buttons. These settings will 
apply to Copy modes. For PC-printing, you need to select the 
paper type and size in the application program you use.

1 Press Menu/Exit until "Paper Setting" appears on the top 
line.

The first menu item, "Paper Size", appears on the bottom 
line.

2 Press Start/Copy to access the menu item.

3 Press Start/Copy when "Tray Paper" displays on the 
bottom line. 

4 Use the scroll button (� or �) to find the paper size you are 
using and press Start/Copy to save it. 

5 Press Menu/Exit to return to the upper menu level.

6 Press the � button to scroll to "Paper Type" and press 
Start/Copy to access the menu item.

7 Use the scroll button (� or �) to find the paper type you 
are using and press Start/Copy to save it. 

8 To return to Standby mode, press Stop/Clear.
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1Using the Save Modes

Toner Save Mode

Toner Save mode allows your machine to use less toner on each 
page. Activating this mode extends the life of the toner cartridge 
longer than normal, but it reduces the print quality.

To turn the toner save mode on or off:

1 Press Menu/Exit until "Toner Save" appears on top line of 
the display.

2 Press the scroll button (� or �) to display "On" on the 
bottom line and press Start/Copy.

Selecting "Off" means that toner save mode turns off.

NOTE: For PC-printing, you can also turn toner save mode on or 
off, in the printer properties. See page 3.9.

Power Save Mode

Power Save mode allows your machine to reduce power 
consumption when it is not in actual use. You can turn this mode 
on by selecting the length of time for which the machine waits 
after a job is printed before it switches to a reduced power state.

1 Press Menu/Exit until "Machine Setup" appears on top line 
of the display.

2 Press the scroll button (� or �) until "Power Save" appears 
on the bottom line. Press Start/Copy.

3 Press the scroll button (� or �) to display "On" on the 
bottom line and press Start/Copy.

Selecting "Off" means that Power Save mode turns off.

4 Press the scroll button (� or �) until the time settings you 
want appears.

The available options are 5, 10, 15, 30 and 45 (minutes). 

5 Press Start/Copy to save the selection.

6 To return to Standby mode, press Stop/Clear.
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MEMO



2 PAPER HANDLING

This chapter introduces you to the basics of selecting 
print materials and loading them into your machine.

This chapter includes:

• Selecting Print Materials

• Selecting an Output Location

• Loading Paper in the Paper Tray

• Using the Manual Feeder
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Selecting Print Materials

You can print on a variety of print materials, such as plain paper, 
envelopes, labels, transparencies, and so on. Always use print 
materials that meet the guidelines for use with this machine. 
See “Paper Specifications” on page A.5. To get the best possible 
print quality, use only high-quality copier-grade paper.

When you choose print materials, consider the following:

• Desired outcome: The paper you choose should be 
appropriate for your project.

• Size: You can use any size paper that fits easily within the 
paper adjusters of the paper tray.

• Weight: Your machine supports paper weights as follows:

- 16 ~ 24 lbs (60 ~ 90 g/m2) bond for the paper tray

- 16 ~ 43 lbs (60 ~ 163 g/m2) bond for the manual feeder

• Brightness: Some papers are whiter than others and produce 
sharper, more vibrant images.

• Surface smoothness: The smoothness of the paper affects 
how crisp the printing looks on the paper.

CAUTION: Using print materials that dose not conform to the 
specifications listed on page A.5 may cause problems that may 
require service. This service is not covered by the warranty or 
service agreements.

Type, Input Sources and Capacities 

Paper Type
Input Source/Capacity*

* Maximum capacity may be reduced depending on the paper thickness.

Paper Tray Manual Feeder

Plain paper 250 1

Envelopes - 1

Labels**

** If you experience excessive jamming, load one sheet at a time through the 
manual feeder.

- 1

Transparency films** - 1

Card stocks** - 1
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Guidelines for Paper and Special Materials

When selecting or loading paper, envelopes, or other special 
material, keep these guidelines in mind:

• Always use paper and other materials that conform with the 
specifications listed under “Paper Specifications” on page A.5.

• Attempting to print on damp, curled, wrinkled, or torn paper 
can cause paper jams and the poor print quality.

• Use only high quality copier grade paper for the best print 
quality. 

• Avoid paper with embossed lettering, perforations, or a 
texture that is too smooth or too rough. Paper jams may 
occur.

• Store paper in its ream wrapper until you are ready to use. 
Place cartons on pallets or shelves, not on the floor. Do not 
place heavy objects on top of the paper, whether it is 
packaged or unpackaged. Keep it away from moisture, or 
other conditions that can cause it to wrinkle or curl.

• Store unused materials at temperatures between 15 oC and 
30 oC (59 oF to 86 oF). The relative humidity should be 
between 10 % and 70 %.

• During storage, you should use moisture-proof wrap, such as 
any plastic container or bag, to prevent dust and moisture 
from contaminating your paper.

• Load special paper types one sheet at a time.

• Only use materials specifically recommended for use in laser 
printers.

• To prevent special materials, such as transparencies and label 
sheets from sticking together, remove them as they prints 
out.

• For envelopes:

- Use only well-constructed envelopes with sharp, well 
creased folds.

- Do not use envelopes with clasps and snaps.

- Do not use envelopes with windows, coated lining, self-
adhesive seals, or other synthetic materials.

- Do not use damaged or poorly made envelopes.

• For transparencies:

- Place them on a flat surface after removing them from the 
machine.

- Do not leave them in the paper tray for long periods of time. 
Dust and dirt may accumulate on them resulting in spotty 
printing.
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- To avoid smudging caused by fingerprints, handle them and 
coated paper carefully.

- To avoid fading, do not expose the printed transparencies to 
prolonged sunlight.

• For labels:

- Verify that their adhesive material can tolerate fusing 
temperature of 200 oC (392o F) for 0.1 second.

- Make sure that there is no exposed adhesive material 
between them. Exposed areas can cause labels to peel off 
during printing, which can cause paper jams. Exposed 
adhesive can also cause damage to machine components.

- Do not load a sheet of them through the machine more than 
once. The adhesive backing is designed for one pass 
through the machine.

- Do not use labels that are separating from the backing 
sheet or are wrinkled, bubbled, or otherwise damaged.

• Do not use Carbonless paper and Tracing paper. They could 
make smell of chemicals and damage your machine. 

Selecting an Output Location

The machine has two output locations; the rear output slot (face 
up) and the front output tray (face down). 

To use the front output tray, make sure that the rear cover is 
closed. To use the rear output slot, open the rear cover.

NOTES: 
• If paper coming out of the front output tray has problems, such 

as excessive curl, try printing to the rear output slot.
• To avoid paper jams, do not open or close the rear cover while 

the machine is printing.
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Printing to the Front Output Tray (Face down)

The front output tray collects printed paper face-down in the 
order in which it was printed. The tray should be used for most 
print jobs.

NOTE: 
• If you continuously print many pages, the surface of the output 

tray may become hot. Be careful not to touch the surface, and 
especially keep children away from the surface.

• The front output tray can hold up to 50 sheets of paper. Remove 
the pages so that the tray is not overloaded.

Printing to the Rear Output Slot (Face up)

Using the rear output slot, paper comes out of the machine face 
up.

Printing from the manual feeder to the rear output slot provides 
a straight paper path. Using the rear output slot might 
improve the output quality with the following:

• envelopes

• labels

• small custom-sized paper

• postcards

• transparencies
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To use the rear output slot:

1 Open the rear cover by pulling it upward. 

CAUTION: The fusing area inside the rear part of your machine 
becomes hot once the machine is turned on. Be careful when you 
access this area.

2 If you do not want to use the rear output slot, close the 
rear cover. The pages stack on the front output tray.
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Loading Paper in the Paper Tray

The paper tray can hold a maximum of 250 sheets of 20 lb(75g/
m2) plain paper. For copying, you can use A4-, Letter- or Legal-
sized paper only. For PC-printing, you can use many different 
sizes of paper; see page A.5.

The paper level indicator on the front of the paper tray shows 
the amount of paper currently left in the tray. When the tray is 
empty, the indicator drops to the bottom.

To load paper, pull open the paper tray and load paper with the 
print side face down.

You can load letterhead paper with the design side face down. 
The top edge of the sheet with the logo should be placed at the 
front side of the tray.

For details about loading paper in the paper tray, see “Loading 
Paper” on page 1.8.

NOTES: 
• If you experience problems with paper feed, place the paper in 

the manual feeder.
• You can load up to 150 sheets of previously printed paper. The 

printed side should be facing up with an uncurled edge on top.
If you experience problems with paper feed, turn the paper 
around. Note that the print quality is not guaranteed.

Paper empty

 Paper full 
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Using the Manual Feeder

Use the manual feeder to print transparencies, labels, envelopes 
or postcards in addition to making quick runs of paper types or 
sizes that are not currently loaded in the paper tray.

Postcards, 3.5 by 5.83 in.(index) cards and other custom-sized 
materials can be printed with this printer. The minimum size is 
76 by 127 mm (3.0 by 5.0 in.) and the maximum size is 216 by 
356 mm (8.5 by 14 in.).

Acceptable print materials are plain paper with sizes ranging 
from 100 x 148 mm (3.9 x 5.8 in.) to Legal, 216 x 356 mm (8.5 
x 14 in.), the largest size acceptable, and weighing between 16 
lb and 32 lb.

NOTES: 
• Always load only the print materials specified in the 

Specifications on page A.5 to avoid paper jams and print quality 
problems.

• Flatten any curl on postcards, envelopes and labels before 
loading them into the manual feeder.

• When you print on 76 mm X 127 mm (3 X 5 in.) sized media with 
loading into the tray, open the rear output tray.

1 Load a sheet of the print material with the print side face 
up into the center of the manual feeder.

For envelopes, load a sheet with the flap side face down 
and with the stamp area on the top left side.

For transparencies, hold them by the edges and avoid 
touching the print side. Oils from your fingers can cause 
print quality problems. 

For letterhead, load a sheet with the design face up, top 
edge towards the printer.
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CAUTION: You must open the rear output slot when you print on 
transparencies. If not, they may tear while exiting the machine.

2 Adjust the paper guide to the width of the print material.

NOTE: When printing on previously printed paper from the 
manual feeder, the printed side should be facing down with an 
uncurled edge to the machine. If you experience problems with 
paper feed, turn the paper around.

3 Open the rear cover to use the rear output slot. 

4 After printing, close the rear cover.
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Setting the Paper Type and Size for the 
Manual Feeder

After loading paper in the manual feeder, you need to set the 
correct paper type and size using the control panel buttons. 
These settings will apply to Copy mode. For PC-printing, you 
need to select the paper size in the application program you use.

To set the paper size for the manual feeder:

1 Press Menu/Exit until "Paper Setting" appears on the top 
line of the display.

The first item, "Paper Size", displays on the bottom line.

2 Press Start/Copy to access the menu item.

3 Use the scroll button (� or �) to display "Manual Feed" on 
the bottom line. Press Start/Copy to access the menu 
item.

4 Use the scroll button (� or �) to find the paper size you are 
using and press Start/Copy to save it. 

5 Press Menu/Exit to return to the upper menu level.

6 Press the � button to scroll to "Paper Type" and press 
Start/Copy to access the menu item.

7 Use the scroll button (� or �) to find the paper type you 
are using and press Start/Copy to save it.

8 To return to Standby mode, press Stop/Clear.
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This chapter explains how to print your documents in 
Windows and how to use the print settings. 

This chapter includes:

• Printing a Document in Windows

• Setting Paper Properties

• Setting Graphic Properties

• Printing Multiple Pages on One Sheet of the Paper

• Printing a Reduced or Enlarged Document

• Fitting Your Document to a Selected Paper Size

• Printing Posters

• Using Watermarks

• Using Overlays

• Setting Up the Locally Shared Printer



PRINTING3.2

Printing a Document in Windows

The following procedure describes the general steps required for 
printing from various Windows applications. The exact steps for 
printing a document may vary depending on the application 
program you are using. Refer to your software application’s 
user’s guide for the exact printing procedure. 

NOTE: For detailed information about printing from Macintosh or 
Linux, see Chapter 6, Using Other Operating Systems.

1 Open the document you want to print.

2 Select Print from the File menu.

The Print window opens. It may look slightly different 
depending on your application.

You can select the basic print settings within the Print 
window. These settings include the number of copies and 
the print range.

3 To take advantage of the printer features provided by your 
machine, click Properties or Preferences in the 
application’s print window and go to step 4. 

If you see a Setup, Printer or Options button, click it 
instead. Then click Properties on the next screen.

� Windows 98

Make sure that your 
machine is selected.
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4 Now you see the Samsung SCX-4100 Series Properties 
window, which allows you to access all of information you 
need when using your machine. 

The Layout tab first displays.   

If necessary, select the Orientation option. 

The Orientation option allows you to select the direction in 
which information is printed on a page. 

• Portrait prints across the width of the page, letter style. 

• Landscape prints across the length of the page, 
spreadsheet style. 

• If you want to turn the page upside down, select 180 from 
the Rotate drop-down list.

5 From the Paper tab, select the paper source, size and type. 
For further details, see page 3.7. 

The preview image 
shows the sample page 
with the settings you 
specified.

�Landscape �Portrait
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6 If necessary, you can set the sequence for the pages to 
print from the Extra tab. Select the print order you want to 
use from the Printer Order drop-down list.

• Normal: Your machine prints from the first page to the 
last page.

• Reverse All Pages: Your machine prints from the last 
page to the first page.

• Print Odd Pages: Your machine prints only the odd 
pages of the document.

• Print Even Pages: Your machine prints only the even 
pages of the document.

7 Click other tabs on the top of the Samsung SCX-4100 
Series Properties window to access other features, if 
needed. 

8 When you finish setting the properties, click OK until the 
Print window displays. 

9 Click OK to start printing. 

The printer’s Properties window may differ, depending on your 
operating system. This User’s Guide shows the Properties 
window on windows 98.

NOTES: 
• Most Windows applications overrides the settings you specified in 

the printer driver. Change all of the print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are 
using the current program. To make your changes permanent, 
make them in the Printers folder. Follow these steps:
1. Click the Windows Start menu.
2. For Windows 95/98/Me/NT 4.0/2000, select Settings and then 

Printers.
For Windows XP, select Printers and Faxes.

3. Select the Samsung SCX-4100 Series printer.
4. Click the right mouse button on the printer icon and: 

• For Windows 95/98/Me, select Properties.
• For Windows 2000/XP, select Printing Preferences.
• For Windows NT 4.0, select Document Default.

5. Change the settings on each tab and click OK.
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Canceling a Print Job

There are two ways to cancel a print job:

To stop a print job from the control panel:

Press the Stop/Clear button. 

Your machine finishes printing the page that is moving through 
the machine and deletes the rest of the print job. Pressing the 
button cancels only the current job. If more than one print job 
is in the machine’s memory, you need to press the button once 
for each job.

To stop a print job from the Printers folder:

If the print job is waiting in a print queue or print spooler, such 
as the Printer group in Windows, delete the job as follows: 

1 Click the Windows Start menu.

2 For Windows 9x/NT4.0/2000/Me, Select Settings and then 
Printers.

For Windows XP, select Printers and Faxes. 

3 Double-click the  Samsung SCX-4100 Series icon.

4 From the Document menu:

For Windows 9x/Me, select Cancel Printing.

For Windows NT4.0/2000/XP, select Cancel.

NOTE: You can access this window simply by double-clicking the 
printer icon at the bottom right corner of the Windows desktop.

� Windows 98
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Using a Favorite Setting

The Favorites option, which is visible on each tab, allows you 
to save the current properties settings for future use. 

To save a Favorites item:

1 Change the settings on each tab, as needed. 

2 Enter a name for the item in the Favorites input box. 

3 Click Save. 

To use a saved setting, select it from the Favorites drop-down 
list. 

To delete a favorite setting item, select it from the list and click 
Delete. 

You can also restore the printer driver’s default settings by 
selecting <Printer Default> from the list. 

Using Help

Your machine has a help screen that can be activated using the 
Help button in the printer’s Properties window. The help screen 
gives detailed information about the printer features provided 
by the printer driver.

You can also click  in the upper right hand corner, and then 
click on any setting. 
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Setting Paper Properties

Use the following options for paper handling. See page 3.2 for 
more information about accessing printer’s Properties. 

Click the Paper tab to access many paper properties. 

Property Description

Copies Copies allows you to choose the number of 
copies to be printed. You can enter up to 999. 

Size Size allows you to choose the size of the paper 
loaded in the tray. 

If the required size is not listed in the Size box, 
click Add Custom. When the Custom Page 
Size window appears, set the size and click Ok. 
The setting appears on the list so that you can 
select it. 

1

2

3

4

1

2

Enter the custom 
name you want to 
use. 

Enter the paper 
size. 
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Setting Graphic Properties

Use the following graphic options to adjust the print quality for 
your specific printing needs. See page 3.2 for more information 
about accessing printer properties.

Click the Graphics tab to display the properties shown below. 

Source Make sure that Source is set to the 
corresponding paper tray.
Use the Manual Feed source when printing to 
special material. You need to load one sheet at a 
time into the manual feeder. See page 2.8.
If the paper source is set to Auto Select, the 
machine automatically picks up print material in 
the following order: the manual feeder and the 
paper tray.

Type Make sure that Type is set to Printer 
Default. If you load a different type of print 
material, select the corresponding paper type. 
For more information about print materials, see 
Chapter 2, Paper Handling.
If you use cotton paper, set the paper type to 
Thick for the best printing.
To use recycled paper, which weighs from 75g/
m2 to 90g/m2 (20lb to 24lb), or colored paper, 
select Color Paper.

Property Description

3

4

1

3

2
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Property Description

Resolution You can select the printing resolution by 
choosing from 600 dpi (Normal) or 300 
dpi (Draft). The higher the setting, the 
sharper the printed characters and graphics. 
Higher settings may increase the time it takes 
to print a document.

Toner Save Selecting this option extends the life of your 
toner cartridge and reduces your cost per page 
without a significant reduction in the print 
quality. 
• Printer Setting: When you select this 

option, the Toner Save feature is 
determined by the setting you’ve made 
on the control panel of the machine.

• On: Select this option to allow the 
machine to use less toner on each page.

• Off: When you do not need to save toner 
to print a document, select this option.

Advanced 
Options 

You can make advanced settings by clicking 
the Advanced Options button. 

1

2

3

Darkness
Use this option to lighten or darken the image 
appearance in your print.
• Normal: This setting is for normal 

documents.
• Light: This setting is for bolder line widths 

or darker grayscale images.
• Dark: This setting is for finer line width, 

higher definition in graphics and lighter 
grayscale images.

When the Darken Text option is checked, all 
text in your document prints darker than 
normal. 
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Printing Multiple Pages on One 
Sheet of the Paper 

You can select the number of pages to print on a single sheet of 
paper. To print more than one page per sheet, the pages are 
smaller and arranged in the order you specified on the sheet. 
You can print up to 16 pages on one sheet.

1 To change the print settings from your software application, 
access the printer’s Properties. See page 3.2.

2 From the Layout tab, choose Multiple Pages per Side 
from the Type drop-down list. 

Advanced 
Options 
(continued)

Property Description

3
True Type Options
This option determines what the driver tells 
the machine about how to image the text in 
your document. Select the appropriate 
setting according to the status of your 
document. 
• Download as Bit Image: When this 

option is selected, the driver downloads 
the font data as bitmap images. 
Documents with complicated fonts, such as 
Korean or Chinese, or various types of 
fonts print faster in this setting. 

• Print as Graphics: When this option is 
selected, the driver downloads any fonts as 
graphics. When printing documents with 
high graphic content and relatively few 
TrueType fonts, printing performance 
(speed) may be enhanced in this setting.

Print All Text Black
When the Print All Text Black option is 
checked, all text in your document prints in 
solid black, regardless of the color it appears 
on the screen. When it is not checked, 
colored text prints in shades of gray.
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3 Select the number of pages you want to print per sheet (1, 
2, 4, 9 or 16) on the Pages per Side drop-down list.

4 Select the page order on the Page Order drop-down list, if 
necessary.

Check Print Page Border to print a border around each 
page on the sheet. 

NOTE: Page Order and Print Page Border are enabled only 
when the number of pages per side is 2, 4, 9 or 16.

5 Click the Paper tab and select the paper source, size, and 
type.

6 Click OK and print the document.

Preview 
image

Right, Then 
Down

Down, Then 
Right

Left, Then 
Down

Down, Then 
Left
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Printing a Reduced or Enlarged 
Document

You can scale your print job on a page. 

1 When you change the print settings from your software 
application, access the printer’s Properties. See page 3.2.

2 From the Layout tab, select Reduce/Enlarge on the 
Type drop-down list. 

3 Enter the scaling rate in the Percentage input box.

You can also click the � or � button.

4 Click the Paper tab and select the paper source, size and 
type. 

5 Click OK and print the document. 

Preview 
image
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Fitting Your Document to a Selected 
Paper Size

You can scale your print job to any paper size regardless of the 
digital document size. This can be useful when you want to 
check the fine details on a small document. 

1 To change the print settings from your software application, 
access the printer’s Properties. See page 3.2.

2 From the Layout tab, select Fit to Page on the Type drop-
down list. 

3 Select the correct size from the Target Page drop-down 
list.

4 Click the Paper tab and select the paper source and type.

5 Click OK and print the document. 

A

Preview 
image
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Printing Posters

You can print a single-page document onto 4, 9 or 16 sheets of 
paper, for the purpose of pasting the sheets together to form 
one poster-sized document.

1 To change the print settings from your software application, 
access the printer’s Properties. See page 3.2.

2 From the Layout tab, select Poster on the Type drop-
down list. 

3 Configure the poster option:

You can select the page layout from 2x2, 3x3 or 4x4. If 
you select 2x2, the image is automatically stretched to 
cover 4 physical pages. 

Specify an overlap in millimeters or inches to make it easier 
to reconstruct the resulting poster. 

Preview 
image

�2 x 2 � 3 x 3

0.15 inches

0.15 inches
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4 Click the Paper tab and select the paper source, size and 
type.

5 Click OK and print the document. You can complete the 
poster by posting the sheets together. 

Using Watermarks

The Watermark option allows you to print text over an existing 
document. For example, you may want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across 
the first page or all of the pages of a document. 

There are several predefined watermarks that come with your 
machine, and they can be modified or you can add new ones to 
the list. 

Using an Existing Watermark

1 To change the print settings from your software application, 
access the printer’s Properties. See page 3.2. 

2 Click the Extras tab and select a watermark on the 
Watermark drop-down list. It appears in the preview 
image window. 

3 Click Ok and start printing. 

Preview 
image
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Creating a Watermark

1 To change the print settings from your software application, 
access the printer’s Properties. See page 3.2. 

2 Click the Extras tab and click Edit in the Watermark 
section. The Edit Watermarks window appears. 

3 Enter text message you want to print in the Watermark 
Message box. 

The message displays in the preview image window.

When the First Page Only box is checked, the watermark 
prints on the first page only.

4 Select the watermark options. 

You can select the font name, style, and size, and gray 
scale level from the Font Attributes section and set the 
angle of the watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list. 

6 When you finish creating, click Ok and start printing. 

To stop printing the watermark, select <No Watermark> on 
the Watermark drop-down list. 
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Editing a Watermark

1 To change the print settings from your software application, 
access the printer properties. See page 3.2.

2 Click the Extras tab and click Edit in the Watermark 
section. The Edit Watermarks window appears.

3 Select the watermark you want to edit on the Current 
Watermarks list, to change the watermark message and 
the options. Refer to page 3.16.

4 Click Update to save the changes.

5 Click Ok.

Deleting a Watermark

1 To change the print settings from your software application, 
access the printer’s Properties. See page 3.2.

2 From the Extras tab, click Edit in the Watermark section. 
The Edit Watermarks window appears.

3 Select the watermark you want to delete on the Current 
Watermarks list and click Delete.

4 When a confirming message window appears, click Yes.

5 Click Ok.
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Using Overlays

What is an Overlay?

An overlay is text and/or images stored on the computer hard 
disk drive (HDD) as a special file format that can be printed on 
any document. Overlays are often used to take the place of 
preprinted forms and letterhead paper. Rather than using 
preprinted letterhead, you can create an overlay containing the 
exact same information that is currently on your letterhead. To 
print a letter with your company’s letterhead, you need only tell 
the machine to print the letterhead overlay on your document.

Creating a New Page Overlay

To use a page overlay, you must create a new page overlay 
containing your logo or image.

1 Create or open a document containing text or an image for 
use in a new page overlay. Position the items exactly as you 
wish them to appear when printed as an overlay. If needed, 
save the file for later use.

2 To change the print settings from your software application, 
access the printer’s Properties. See page 3.2.

3 Click the Extras tab and click Edit in the Overlay section. 

WORLD BEST

Dear ABC

Regards
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4 In the Edit Overlays window, click Create Overlay. 

5 In the Create Overlay window, type a name of up to eight 
characters in the File name box. Select the destination 
path, if necessary. (The default is C:\Formover).

6 Click Save. The name appears on the Overlay List. 

7 Click Ok or Yes to finish creating. 

The file is not printed out. Instead it is stored in your 
computer HDD disk. 

NOTE: The overlay document size must be the same as the 
documents you print with the overlay. Do not create an overlay 
with a watermark.
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Using a Page Overlay

After an overlay has been created, it is ready to be printed with 
your document. To print an overlay with a document:

1 Create or open the document you want to print. 

2 To change the print settings from your software application, 
access the printer’s Properties. See page 3.2. 

3 Click the Extras tab. 

4 Select the overlay you want to print from the Overlay 
drop-down list box. 

5 When the overlay file you want doesn’t appear on the 
Overlay List, click Edit and Load Overlay, and select the 
overlay file. 

If you have stored the overlay file you want to use in an 
external source, you can also load the file when you access 
this Load Overlay window. 

After you select the file, click Open. The file appears on the 
Overlay List and is available for printing. Select the overlay 
from the Overlay List box. 
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6 If necessary, click Confirm Page Overlay When 
Printing. When this box is checked, a message window 
appears each time you submit a document for printing, 
asking you to confirm your wish to print an overlay on your 
document.

Answering Yes to the window means that the selected 
overlay prints with your document. Answering No to the 
window cancels overlay printing.

If this box is empty and an overlay has been selected, the 
overlay will be automatically printed with your document.

7 Click OK or Yes until the printing starts.

The overlay downloads with your print job and prints on 
your document.

NOTE: The resolution of the overlay document must be the same 
as that of the document you will print with the overlay.

Deleting a Page Overlay

You can delete page overlays that you no longer use.

1 In the printer’s properties window, click the Extras tab.

2 Click Edit in the Overlay section.

3 Select the overlay you want to delete from the Overlay List 
box.

4 Click Delete Overlay.

5 When a confirming message window appears, click Yes.

6 Click OK until you exit the Print window.
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Setting Up the Locally Shared Printer

You can connect the machine directly to a selected computer, 
which is called “host computer,” on the network. Your machine 
can be shared by other users on the network through a Windows 
9x, Me, 2000, XP or NT 4.0 network printer connection. 

NOTE: Whether the printer is locally connected or network-
connected, you need to install the printer software on each 
computer that will print documents to the printer.

In Windows 9x/Me

Setting Up the Host Computer

1 Start Windows.

2 From the Start menu, select Control Panel and 
double-click on the Network icon. 

3 Check the File and Print Sharing box and click OK. 

4 Click Start and select Printers from Settings. Double-
click your printer icon. 

5 Select Properties in the Printer menu. 

6 Click the Sharing tab and check the Shared As box. Fill in 
the Share Name field and then click OK. 



PRINTING 3.23

3

Setting Up the Client Computer

1 Right-click Start and select Explorer. 

2 Open your network folder in the left column. 

3 Right-click the shared name and select Capture Printer 
Port. 

4 Select the port you want, check the Reconnect at log on 
box and then click OK.

5 From the Start menu, select Settings and then Printers. 

6 Double-click your printer icon. 

7 From the Printer menu, select Properties. 

8 From the Details tab, select the printer port and click OK.

In Windows NT 4.0/2000/XP

Setting Up the Host Computer

1 Start Windows. 

2 For Windows NT 4.0/2000, from the Start menu, select 
Settings and then Printers. 

For Windows XP, from the Start menu, select Printers and 
Faxes. 

3 Double-click your printer icon. 

4 From the Printer menu, select Sharing. 

5 For Windows NT 4.0, check the Shared box. 

For Windows 2000, check the Shared As box.

For Windows XP, check the Share this printer box. 

6 For Windows NT 4.0, fill in the Share Name field and click 
OK. 

For Windows 2000/XP, fill in the Shared Name field and 
click OK. 
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Setting Up the Client Computer

1 Right-click Start and select Explorer. 

2 Open your network folder in the left column. 

3 Click the shared name. 

4 For Windows NT 4.0/2000, from the Start menu, select 
Settings and Printers. 

For Windows XP, from the Start menu, select Printers and 
Faxes.

5 Double-click your printer icon. 

6 From the Printer menu, select Properties. 

7 Press the Ports tab and click Add Port. 

8 Select Local Port and click New Port. 

9 Fill in the Enter a port name field and enter the shared 
name. 

10 Click OK and click Close. 

11 For Windows NT 4.0, click OK.

For Windows 2000/XP, click Apply and click OK.



4 COPYING

This chapter gives you step-by-step instructions for copying 
documents.

This chapter includes:

• Loading Paper for Copying

• Preparing a Document

• Making a Copy

• Setting Copy Options

• Using Special Copy Features

• Changing the Default Settings

• Setting the Time Out Option
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Loading Paper for Copying

The instructions for loading print materials are the same 
whether you are printing, or copying. For coping, you can use 
Letter-, A4-, Legal-sized print materials. For further details, see 
page 1.8 for loading in the paper tray and page 2.8 for loading 
in the manual feeder.

Preparing a Document

You can use an original document for copying and scanning.

Load booklet, pamphlet, or documents having unusual 
characteristics on the document glass one sheet at a time. On 
the document glass, you can load the following types of 
documents:

• Thick paper

• Document with uneven surface

• Photographs

• Small documents (e.g. business cards, postcards)

• Special types of paper

Making a Copy

1 Lift and open the document cover.
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2 Place the document face down on the document glass.

3 Align it with the registration guide on the top left corner of 
the glass.

4 Close the document cover. Be careful not to move the 
document.

NOTES:

• Leaving the cover open while copying may affect the copy quality 
and toner consumption.

• If you are copying a page from a book or magazine which is 
thicker than 30 mm, lift the cover straight up to remove it and 
start copying with the cover open.
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5 Customise the copy settings including number of copies, 
copy size, darkness and original type by using the control 
panel buttons. See “Setting Copy Options” on page 4.4.

To clear the settings, use the Stop/Clear button.

6 Press Start/Copy to begin copying. The display shows the 
copy processing.

NOTES:

• You can cancel the copy job during an operation. Press Stop/
Clear, and the copying will stop.

• Dust on the document glass may cause black spots on the 
printout. Keep it always clean.

Setting Copy Options

The buttons on the control panel let you make all the basic copy 
options; darkness, number of copies, copy size and document 
type. Set the following options for the current copy job before 
pressing Start/Copy to make copies.

NOTE: If you press Stop/Clear while you set the copy options, all 
of the options you have set for the current copy job will be 
canceled and return to their default status. Or, they will 
automatically return to their default status after the machine 
completes the copy. 

Darkness

If you have an original document containing faint markings and 
dark images, you can adjust the brightness to make a copy that 
is easier to read. 

To adjust the contrast, press Darkness. 

You can choose from the following contrast modes:

• Light: works well with dark print.

• Normal: works well with standard typed or printed 
documents.

• Dark: works well with light print or faint pencil markings. 
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Number of Copies

Using the No. of Copies button, you can select the number of 
copies from 1 to 99. 

1 Press No. of Copies.

2 Press the scroll button (� or �) until the number you want 
appears on the display.

Pressing and holding the buttons allows you to quickly 
increase and decrease in increments of 5.

3 Press Start/Copy to save the selection.

Reduced/Enlarged Copying

You can reduce or enlarge the size of a copied image from 50% 
to 200%.

To select from the predefined copy sizes:

1 Press Menu/Exit on the control panel. 

"Reduce/Enlarge" appears on the top line of the display.

2 Press the scroll button (� or �) to find the size setting you 
want. 

3 Press Start/Copy to save the selection.

To fine-tune the size of copies:

1 Press Menu/Exit on the control panel. 

"Reduce/Enlarge" appears on the top line of the display.

2 Press the scroll button (� or �) until "Custom:50-200%" 
displays on the bottom line. Press Start/Copy.

3 Press the scroll button (� or �) until the copy size you want 
appears on the display. 

Pressing and holding the buttons allows you to quickly 
increase and decrease in increments of 5. 
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4 Press Start/Copy to save the selection.

NOTE: When you make a reduced copy, black lines may appear at 
the bottom of your copy.

Original Type

The Original Type setting is used to improve the copy quality by 
selecting the document for the current copy job. 

To select the document type:

1 Press Menu/Exit on the control panel until "Original Type" 
appears on the top line of the display

2 Press Start/Copy to access the menu item. 

3 Press the scroll button (� or �) to scroll through the 
document type. 

You can choose from the following image modes:

• Text: Use for documents containing mostly text.

• Text/Photo: Use for documents with mixed text and 
graphics.

• Photo: Use when the originals are photographs.

NOTE: When you copy a document containing color on the 
background, such as a newspaper or a catalog, you can get the 
background on your copy. If you want to reduce the background, 
change the Darkness setting to Light and/or the Original Type 
setting to Text.
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Using Special Copy Features

You can use the following copy features using the "Special Copy" 
menu:

• Off: Prints in normal mode.

• Clone: Prints multiple image copies from the original 
document on a single page. The number of images is 
automatically determined by the original image and paper 
size. See page 4.7.

• Auto Fit: Automatically reduces or enlarges the original 
image to fit on the paper currently loaded in the machine. 
See page 4.8.

• 2 Sides in 1 pg: Prints 2-sided original document on one 
sheet of paper. See page 4.8.

• 2 Up: Prints 2 original images reduced to fit onto one 
sheet of paper. See page 4.9.

• Poster: Prints an image onto 9 sheets of paper (3x3). You 
can paste the printed pages together to make one poster-
size document. See page 4.10.

Clone Copying

1 Load the document to be copied on the document glass, 
and close the cover. 

2 Press Menu/Exit until "Special Copy" appears on the top 
line of the display. 

3 Press the scroll button (� or �) until "Clone" displays on 
the bottom line.

4 Press Start/Copy to save the selection.

5 Customise the copy settings including number of copies, 
copy size, darkness and original type by using the control 
panel buttons. See “Setting Copy Options” on page 4.4.

NOTE: You cannot adjust the copy size using the "Reduce/
Enlarge" feature while making a clone copy.

6 Press Start/Copy to begin copying.
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Auto Fit Copying

1 Load the document to be copied on the document glass, 
and close the cover. 

2 Press Menu/Exit until "Special Copy" appears on the top 
line of the display. 

3 Press the scroll button (� or �) until "Auto Fit" appears on 
the bottom line.

4 Press Start/Copy to save the selection.

5 Customise the copy settings including number of copies, 
copy size, darkness and original type by using the control 
panel buttons. See “Setting Copy Options” on page 4.4.

NOTE: You cannot adjust the copy size using the "Reduce/
Enlarge" feature while the Auto Fit copying is enabled.

6 Press Start/Copy to begin copying.

2 sided in 1 page Copying

You can copy a 2-sided document on one page of A4, Letter or 
Legal-sized paper. 

When you copy using this feature, the machine prints one side 
on the upper half of the paper and the other side on the lower 
half without reducing the original. This feature is helpful for 
copying a small-sized document, such as a name card. 

If the original document is larger than the printable area, some 
portions may not be printed.

1 Load the document to be copied on the document glass, 
and close the cover. 

2 Press Menu/Exit until "Special Copy" appears on the top 
line of the display. 

3 Press the scroll button (� or �) until "2 Sides in 1 pg" 
displays on the bottom line.

4 Press Start/Copy to save the selection.

A
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5 Customise the copy settings including number of copies, 
copy size, darkness and original type by using the control 
panel buttons. See “Setting Copy Options” on page 4.4.

6 Press Start/Copy to begin copying.

Your machine begins scanning the front side.

7 When "Set Backside" displays on the bottom line, open the 
document cover and flip the document over. Close the 
cover.

NOTE: If you press the Stop/Clear button or if no buttons are 
pressed for about 30 seconds, the machine cancels the copy job 
and returns to Standby Mode.

8 Press Start/Copy again.

NOTE: You cannot adjust the copy size using the "Reduce/
Enlarge" feature for making a 2-side Copying.

2-up Copying

1 Load the document to be copied on the document glass, 
and close the cover. 

2 Press Menu/Exit until "Special Copy" appears on the top 
line of the display. 

3 Press the scroll button (� or �) until "2 UP" displays on the 
bottom line.

4 Press Start/Copy to save the selection.

5 Customise the copy settings including number of copies, 
copy size, darkness and original type by using the control 
panel buttons. See “Setting Copy Options” on page 4.4.

NOTE: You cannot adjust the copy size using the "Reduce/
Enlarge" feature for making a 2-up copy.

6 Press Start/Copy to begin copying.

 2-up copying
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NOTE: 2-up copy reduces your original document by 50%. 

Poster Copying

1 Load the documents to be copied on the document glass 
and close the cover.

2 Press Menu/Exit until "Special Copy" appears on the top 
line of the display. 

3 Press the scroll button (� or �) until "Poster" displays on 
the bottom line.

4 Press Start/Copy to save the selection.

5 Customise the copy settings including number of copies, 
copy size, darkness and original type by using the control 
panel buttons. See “Setting Copy Options” on page 4.4.

NOTE: You cannot adjust the copy size using the "Reduce/
Enlarge" feature for making a poster.

6 Press Start/Copy to begin copying.

Your original document is divided into 9 
portions. Each portion is scanned and 
printed one by one in the following order:
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Changing the Default Settings

Copy options, including darkness, original type, copy size and 
number of copies, can be set to the most frequently used 
modes. When you copy a document, the default settings are 
used unless they are changed by using the corresponding 
buttons on the control panel.

To create your own default settings:

1 Press Menu/Exit on the control panel until "Copy Setup" 
appears on the top line of the display. 

The first menu item, "Change Default", appears on the 
bottom line.

2 Press Start/Copy to access the menu item. The first setup 
option, "Darkness", appears on the bottom line.

3 Press the scroll button (� or �) to scroll through the setup 
options.

4 When the option you want to set appears, press Start/
Copy to access the option.

5 Change the setting using the scroll button (� or �).

6 Press Start/Copy to save the selection.

7 Repeat steps 3 through 6, as needed.

8 To return to Standby mode, press Stop/Clear.

NOTE: While you set copy options, pressing Stop/Clear cancels 
the changed settings and restores their default status.
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Setting the Time Out Option

You can set the time the machine waits before it restores the 
default copy settings, if you do not start copying after changing 
them on the control panel.

1 Press Menu/Exit on the control panel until "Copy Setup" 
appears on the top line of the display. 

2 Press the scroll button (� or �) to display "Timeout" on the 
bottom line.

3 Press Start/Copy to access the menu item.

4 Press the scroll button (� or �) until the status you want 
appears on the display.

You can select from 15, 30, 60 and 180 (seconds). 
Selecting "Off" means that the machine does not restore 
the default settings until you press Start/Copy to start 
copying, or Stop/Clear to cancel.

5 Press Start/Copy to save the selection.

6 To return to Standby mode, press Stop/Clear.



5 SCANNING

Scanning with your machine lets you turn pictures and 
text into digital files on your computer. Then you can e-
mail the files, display them on your web site or use them 
to create projects that you can print using Samsung 
SmarThru software.

This chapter includes:

• Scanning Basics

• Scanning Using Samsung SmarThru

• Scanning Process with TWAIN-enabled Software




